Preface

Purpose

This book provides information about Teradata SQL Assistant/Web Edition, which is a Teradata Tools and Utilities product. Teradata Tools and Utilities is a group of products designed to work with Teradata Database.

Teradata SQL Assistant/Web Edition is a Web-based query tool that enables you to compose a query, submit it to the Teradata Database and view the results from a Web browser. Then you can save the data on your PC for analysis.

Audience

This book is intended for use by:

- Relational database developers and SQL proficient developers who know how to formulate queries for processing on Teradata.
- Other users who interface with the Teradata Database.

Supported Releases

This book supports the following releases:

- Teradata Database 13.0
- Teradata Tools and Utilities 13.00.00
- Teradata SQL Assistant/Web Edition 13.00.00

Note: See “Table 1: Toolbar Icon Description” on page 24 and look at the Information icon to learn how to verify the Teradata SQL Assistant/Web Edition version number.

To locate detailed supported-release information:

3. Type 3119 in the Publication Product ID box.
4. Under Sort By, select Date.
5. Click Search.
6. Open the version of the Teradata Tools and Utilities ##.##.## Supported Platforms and Product Versions spreadsheet associated with this release.
The spreadsheet includes supported Teradata Database versions, platforms, and product release numbers.

**Prerequisites**

The following prerequisite knowledge is required for this product:

- Computer technology and terminology
- Basic concepts of the Teradata Database
- Teradata SQL
- Connectivity software, such as ODBC
- Windows operating system

**Changes to This Book**

The following changes were made to this book in support of the current release. Changes are marked with change bars. For a complete list of changes to the product, see the Release Definition associated with this release.

<table>
<thead>
<tr>
<th>Date and Release</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aug 2008</td>
<td>No technical changes to this book.</td>
</tr>
</tbody>
</table>

**Additional Information**

Additional information that supports this product and Teradata Tools and Utilities is available at the web sites listed in the table that follows. In the table, \textit{mmyx} represents the publication date of a manual, where \textit{mm} is the month, \textit{y} is the last digit of the year, and \textit{x} is an internal publication code. Match the \textit{mmy} of a related publication to the date on the cover of this book. This ensures that the publication selected supports the same release.
<table>
<thead>
<tr>
<th>Type of Information</th>
<th>Description</th>
<th>Access to Information</th>
</tr>
</thead>
</table>
| Release overview            | Use the Release Definition for the following information:  
|                             | • Overview of all of the products in the release  
|                             | • Information received too late to be included in the manuals  
|                             | • Operating systems and Teradata Database versions that are certified to work with each product  
|                             | • Version numbers of each product and the documentation for each product  
|                             | • Information about available training and the support center                                                                                                                                                                                                                                                                     | 1 Go to [http://www.info.teradata.com/](http://www.info.teradata.com/).  
|                             | 3 Type 2029 in the [Publication Product ID](http://www.info.teradata.com/) box.  
|                             | 4 Click [Search](http://www.info.teradata.com/).  
|                             | 5 Select the appropriate Release Definition from the search results.                                                                                                                                                                                                                                                                   |                                                                                                                                                                                                                                                |
| Late information            |                                                                                                                                                                                                                                                                                                                                            |                                                                                                                                                                                                                                                |
| Additional product information | Use the Teradata Information Products website to view or download specific manuals that supply related or additional information to this manual.                                                                                                                                                                                                                      | 1 Go to [http://www.info.teradata.com/](http://www.info.teradata.com/).  
|                             | 2 Under the [Online Publications](http://www.info.teradata.com/) subcategory, [Browse by Category](http://www.info.teradata.com/), click [Data Warehousing](http://www.info.teradata.com/).  
|                             | 3 Do one of the following:  
|                             | • For a list of Teradata Tools and Utilities documents, click [Teradata Tools and Utilities](http://www.info.teradata.com/), and then select an item under [Releases](http://www.info.teradata.com/) or [Products](http://www.info.teradata.com/).  
|                             | • Select a link to any of the data warehousing publications categories listed.                                                                                                                                                                                                                                                          | Specific books related to Teradata SQL Assistant/Web Edition are as follows:  
|                             | • [Teradata Manager User Guide](http://www.info.teradata.com/)  
|                             | B035-2428-**my**y  
|                             | • [ODBC Driver for Teradata User Guide](http://www.info.teradata.com/)  
|                             | B035-2509-**my**y  
|                             | • [Messages](http://www.info.teradata.com/)  
|                             | B035-1096-**my**y  
| CD-ROM images               | Access a link to a downloadable CD-ROM image of all customer documentation for this release. Customers are authorized to create CD-ROMs for their use from this image.                                                                                                                                                                           | 1 Go to [http://www.info.teradata.com/](http://www.info.teradata.com/).  
|                             | 2 Under the [Online Publications](http://www.info.teradata.com/) subcategory, [Browse by Category](http://www.info.teradata.com/), click [Data Warehousing](http://www.info.teradata.com/).  
|                             | 3 Click [CD-ROM List and Images](http://www.info.teradata.com/).  
|                             | 4 Follow the ordering instructions.                                                                                                                                                                                                                                                                                                     |                                                                                                                                                                                                                                                |
| Ordering information for manuals | Use the Teradata Information Products website to order printed versions of manuals.                                                                                                                                                                                                                                                      | 1 Go to [http://www.info.teradata.com/](http://www.info.teradata.com/).  
|                             | 2 Select the [How to Order](http://www.info.teradata.com/) check box under [Print & CD Publications](http://www.info.teradata.com/).  
|                             | 3 Follow the ordering instructions.                                                                                                                                                                                                                                                                                                    |
The Teradata home page provides links to numerous sources of information about Teradata. Links include:

- Executive reports, case studies of customer experiences with Teradata, and thought leadership
- Technical information, solutions, and expert advice
- Press releases, mentions, and media resources

<table>
<thead>
<tr>
<th>Type of Information</th>
<th>Description</th>
<th>Access to Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>General information about Teradata</td>
<td>The Teradata home page provides links to numerous sources of information about Teradata. Links include:</td>
<td>1 Go to Teradata.com.</td>
</tr>
<tr>
<td></td>
<td>• Executive reports, case studies of customer experiences with Teradata, and thought leadership</td>
<td>2 Select a link.</td>
</tr>
<tr>
<td></td>
<td>• Technical information, solutions, and expert advice</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Press releases, mentions, and media resources</td>
<td></td>
</tr>
</tbody>
</table>
# Chapter 2: Using the Query Pane

- **About the Query Pane** ............................................. 33
- **Before You Begin** .................................................. 33
- **Aborting Queries** .................................................. 34
- **How to Use the Query Pane** ................................... 34
- **Saving a Query** ..................................................... 35
- **Automatically Running a Query from a File** ............... 35
- **Loading a Query from a File Without Running It** .......... 36
- **Aborting a Query in Progress** ................................ 36
- **Executing a Query for Large Objects (LOBs)** .............. 36
- **Saving Large Objects** .............................................. 38
- **Printing a Query** ................................................... 38

## Using Query Builder

- **Building a Query** .................................................. 39
- **Inserting a Statement or Procedure into the Query Window** ............................................. 40

# Chapter 3: Using the Answer Set Pane

- **About the Answer Set Pane** .................................... 41
- **How to Use the Answer Set Pane** ......................... 41
- **Viewing Your Results** ........................................... 42
- **Sorting an Answer Set** ........................................... 42
- **Reordering Columns in an Answer Set** .................... 42
- **Saving an Answer Set to a File** .............................. 42
- **Opening a Saved Answer Set with Microsoft Excel** ....... 43
- **Copying an Answer Set to the Clipboard** .................. 43
- **Printing the Answer Set Table** ................................. 43
Chapter 4: Using the History Pane

About the History Pane 45
History Pane Control Items 46
How to Use the History Pane 47
  Viewing Additional History Tables 47
  Copying Queries from History Pane to the Query Pane 47
  Sorting History 47
  Adding Notes 47
  Saving History Rows 48
  Copying Rows to the Clipboard 48
  Clearing History Rows 48
  Printing the History Table 49
  Viewing Error Code Information 49
  Using the Edit History Dialog 49

Chapter 5: Using the Database Explorer Tree

About the Database Explorer Tree 53
How to Use Database Explorer Tree 54
  Showing or Hiding the Database Explorer Tree 54
  Resizing the Database Explorer Tree Area 54
  Viewing Object Types 54
  Object Types in the Database Explorer Tree 54
  Adding or Removing a Database 55

Appendix A: Troubleshooting

Error Codes in the History Table 57
Browser Messages and Errors 58
Helpful Hints 58
  INTERVAL Data Type 59
  TITLE Keyword 59
  Restarting the ASPNet_wp.exe Process 59
Table of Contents

Glossary/Acronyms

Index
List of Figures

Figure 1: SQL Assistant Architecture ........................................... 16
Figure 2: The Options Dialog Box.................................................. 27
Figure 3: Example of a Query Explanation...................................... 30
Figure 4: Query Text Box Shortcut Menu ...................................... 30
Figure 5: LOB Dialog Box.............................................................. 37
Figure 6: Answer Set Pane Showing a BLOB Answer Set ................. 38
Figure 7: Query Print Preview Window ......................................... 38
Figure 8: Query Builder Window ................................................... 39
Figure 9: Answer set print preview window ................................. 44
Figure 10: Print History Window .................................................. 49
Figure 11: Edit History Dialog Box .............................................. 50
List of Tables

Table 1: Toolbar Icon Description ......................................................... 24
Table 2: Description of the Option Dialog .............................................. 25
Table 3: Query Text Box Shortcut Menu Commands and Descriptions .......... 31
Table 4: Microsoft Internet Explorer Commands and Shortcut Keys ............... 31
Table 5: LOB Dialog Box Field Descriptions ........................................... 37
Table 6: Query Builder Options ............................................................. 39
Table 7: History Pane Column Descriptions ............................................. 46
Table 8: Edit History Dialog Field Descriptions ....................................... 50
Table 9: Solutions to Error Codes in the History Table ................................ 57
Table 10: Solutions to Browser Messages and Errors ................................ 58
In this chapter, you will learn information you need before using SQL Assistant. This chapter contains the following information:

- SQL Assistant Overview
- Setting Up an ODBC Connection on the Server PC
- Starting SQL Assistant
- Disconnecting and Closing SQL Assistant
- Overview of the SQL Assistant Interface
- Printing

Note: In this user guide, Teradata SQL Assistant/Web Edition is called SQL Assistant.

**SQL Assistant Overview**

In this overview, you learn about SQL Assistant, its features, and how it works.

**How SQL Assistant Can Help You**

SQL Assistant is a Web-based query tool that enables you to compose a query, submit it to the Teradata Database, view the results from a Web browser, and save the data on your PC for analysis.

Using SQL Assistant, you can save the data retrieved from Teradata Databases to create consolidated reports or to analyze the data. SQL Assistant gives you SQL activity, complete with source identification, timings, row counts, and your notes. This is useful because you can use the historical record to build SQL scripts and then modify the scripts to gather more specific results.

**Key Features**

Using SQL Assistant, you can:

- Send queries to any Teradata Database.
- View and sort the results by column and save them to a file.
- Save queries to a file so you can run them automatically from the same file in the future.
- Load queries from a file and make changes before submitting them to the database.
Chapter 1: Getting Started
SQL Assistant Overview

- View historical records of the queries you have submitted with timings and status information. You can sort the history rows by column, update them with your notes, and save the records to a file.
- View a hierarchical listing of databases with object names to reduce the time required to create SQL statements.
- Use the browser’s built-in find features to do a string search on a query, an answer set, or any information in the historical table visible in the browser window.
- Abort a query in progress if you change your mind about running a query or if a query is taking longer than you expected.

Also, to maintain security and help maximize your server’s resources, your browser’s connection ends after 30 minutes of inactivity.

How SQL Assistant Works

SQL Assistant uses a Web browser to interface to the Teradata Database. This design lets you connect several client PCs to one server PC where the application and its associated connectivity software is installed. Client PCs require Microsoft Internet Explorer 5.5 or later or Netscape 7 or later to access the Teradata Database.

<table>
<thead>
<tr>
<th>If you use</th>
<th>Install</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Internet Explorer 5.5</td>
<td>IE 5.5 Service Pack 2</td>
</tr>
<tr>
<td>Microsoft Internet Explorer 6.0</td>
<td>IE 6.0 Service Pack 1</td>
</tr>
</tbody>
</table>

Figure 1: SQL Assistant Architecture

Client PCs  
Server PC  
Teradata Database
Server PC

After installing SQL Assistant and the connectivity software on the server PC, you can send queries to the Teradata Database. The database retrieves the data and returns the results back to your server PC.

<table>
<thead>
<tr>
<th>Install</th>
<th>if you want</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2000 Professional, XP</td>
<td>less than 10 client PC connections.</td>
</tr>
<tr>
<td>Windows 2000 Server</td>
<td>more than 10 client PC connections.</td>
</tr>
<tr>
<td>Windows Server 2003</td>
<td>more than 10 connections.</td>
</tr>
</tbody>
</table>

If you installed a Windows Server OS and want to change the number of client PC connections, see “Setting the Number of Client Connections” on page 18 or Teradata Tools and Utilities Installation Guide for Microsoft Windows.

Client PCs

If you are a client PC user running any Windows operating system, you need to have only a Microsoft Internet Explorer Web browser (version 5.50 or later) or Netscape 7 (or later) installed. As long as your server PC has an active connection to the Teradata Database, your client PC can send queries to the database.

Teradata Database

You can send queries to any database as long as your DBA has set access permissions.

Setting Up an ODBC Connection on the Server PC

Before you use SQL Assistant on a server PC, you must install a Teradata Database Open Database Connectivity (ODBC) driver. The driver lets you connect to a Teradata Database from SQL Assistant.

After installing the driver, you must also define a data source on the server PC for each Teradata Database you want to use before you can access the data in the Teradata Database.

If you need additional information on setting up an ODBC connection, refer to ODBC Driver for Teradata User Guide. See “Additional Information” on page 4.

Installing a Teradata Database ODBC Driver

The Teradata Database ODBC driver is designed specifically for the Teradata Database system. You can obtain the driver from your Teradata Database vendor.

Client PCs do not need to install an ODBC driver. Only server PCs must install the ODBC driver.
For information on installing a Teradata Database ODBC driver, refer to Teradata Tools and Utilities Installation Guide for Microsoft Windows.

**Defining a Data Source**

After you install a Teradata Database ODBC driver on your server PC, you need to define a data source for each Teradata Database.

You use the ODBC Data Source Administrator to configure some features of the drivers installed on your system.

You also use the ODBC Data Source Administrator to create ODBC data sources.

**Types of Data Sources**

There are two types of data sources: File DSN and System DSN.

You can connect to only one data source at a time, however, you can define as many as you like.

---

**To define a data source**

1. Open the ODBC Data Source Administrator by clicking **Start > Programs > OBDC > 32-bit ODBC Administrator**.

2. In the **ODBC Data Source Administrator** dialog box, choose a DSN.
   - From the **User DSN** tab, click **Add**.
   - or-
   - From the **System DSN** tab, click **Add**.

3. In the **Create New Data Source** dialog box, select **Teradata** as the driver for which you want to set up a data source from the **Name** column.

4. Click **Finish**. The **ODBC Driver Setup** dialog box opens. This dialog box is specific to the Teradata Database.

5. Complete the fields in the **ODBC Driver Setup** dialog.

6. When finished, click **OK** to close the **ODBC Driver Setup** dialog box and return to the ODBC Data Source Administrator.

7. Click **OK** to close the ODBC Data Source Administrator and return to your Windows desktop.

**Note for System Administrator**: If you will have any client PCs access your server PC, we recommend you leave the Default Database, Username, Password, and Account String fields blank. However, if you plan to set up different DSNs for each category of user, you can enter a default database and account string at this time.

**Setting the Number of Client Connections**

If you have Windows Server OS installed, you can adjust the number of client PCs that connect to your server PC. Typically, this is done by your system administrator.
To change the connections setting

1. Click the Start button. Next, go to Settings, then Control Panel, then Administrative Tools, and click Internet Services Manager.
2. In the left panel, click the plus sign (+) next to your computer name to expand the tree.
3. Right-click the Default Web Site folder, and choose Properties. The Default Web Site Properties dialog box opens.
4. From the Web Site tab, choose one of the following options:

<table>
<thead>
<tr>
<th>Select This Option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlimited</td>
<td>Allow an unlimited number of connections to occur simultaneously.</td>
</tr>
<tr>
<td>Limited to &lt;number&gt; connections</td>
<td>Limit the maximum number of simultaneous connections to the site.</td>
</tr>
</tbody>
</table>

5. Click Apply.
6. Click OK to close the Default Web Site Properties dialog box.

Starting SQL Assistant

To start SQL assistant

1. Find the computer name of the server or, the IP address of the server PC.
2. Connect to a database through a browser which starts SQL Assistant.

If you already know the computer name or IP address of your server PC, you can connect to a Teradata Database. See “To connect to a Teradata Database” on page 20.

Finding the Computer Name or IP Address of Your Server PC

To determine the computer name of your server PC

1. On your desktop, right-click My Computer.
2. From the menu, select Properties.
3. Click the Network Identification tab. The computer name is the Full computer name shown.
Chapter 1: Getting Started

Starting SQL Assistant

To determine the server PCs IP address

1 Click the Start button. Next, go to Programs, select Accessories, and then click Command Prompt.

2 At the prompt, type the following:
   ping <computer name>
   The four groups of numbers, each separated by a period is the IP address. For example, 153.64.138.72.

3 Write down the number.

4 At the prompt, type exit. This will close the Command Prompt window.

Now you are ready to connect to the Teradata Database.

Connecting to a Teradata Database

To connect to a Teradata Database

1 Open a Microsoft Internet Explorer browser.

2 In the Address bar, enter a URL that includes the same name of the directory where you installed SQL Assistant.
   In the following example, the user installed SQL Assistant on a server PC in the default location, a virtual directory name called SQLAssistantWeb.

3 You can save this URL for quick access in the future. In the Microsoft Internet Explorer browser, from the Favorites menu, click Add to Favorites.

4 Choose a database by clicking a database name in the DSN column.
Chapter 1: Getting Started
Starting SQL Assistant

5 The **DBC Name or Address** text box is filled in automatically. Enter a **Username** and **Password** to connect to the Teradata Database.

<table>
<thead>
<tr>
<th>DSN</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Qforce</td>
<td>Teradata Machine</td>
</tr>
<tr>
<td>savak</td>
<td></td>
</tr>
<tr>
<td>agass:</td>
<td></td>
</tr>
<tr>
<td>Savak:2</td>
<td></td>
</tr>
<tr>
<td>Troy Server</td>
<td></td>
</tr>
</tbody>
</table>

6 (Optional) In the **Default Database** box, enter the default database you want to use with this logon.

All tables, views, and **macros** are assumed to be in this default database unless they are explicitly prefixed by a database name in the query.

7 (Optional) In the **Account String** box, enter any additional logon parameters that define your user group.

8 Click **OK**.

**Note:** Existing browser encryption is used to prevent your username and password from being compromised.

You know the connection is complete when the SQL Assistant main Web page appears with a blank Query text box, a History pane, and an Answer Set pane at the bottom.
Disconnecting and Closing SQL Assistant

Your session does not expire or end when you close your browser. You must use the Disconnect button to end your session. Also, your session does not expire if your browser becomes unresponsive.

To close SQL Assistant

1. In your browser, click **Disconnect Button** located on the **Tool** bar.
   After disconnecting, you can connect to another database if desired, or simply close your browser window.

2. To close Microsoft Internet Explorer, from the **File** menu, choose **Close**.

Overview of the SQL Assistant Interface

The SQL Assistant main Web page is divided into several panes: a Query pane, a History pane, and an Answer Set pane. The Database Explorer Tree is an optional pane on the left side.

Click the blue links around the following illustration to read more about a particular key area.
Browser Menu Bar

The menu bar in the browser runs along the top of the browser window. You can use the menu bar to access features specific to your browser.

In Microsoft Internet Explorer, the menus are File, Edit, View, Favorites, Tools, and Help.

Note: The Help menu is for the browser, not for SQL Assistant. You can find the Help for the application in the Action and Information Bar, to the far right.

Find Feature

Use the built-in find feature in your browser to do a string search on a query, an answer set, or any information in the history visible in the browser window. From the Edit menu, choose Find (on This Page).

Browser Toolbar

You can use the toolbar to access features specific to your browser. In Microsoft Internet Explorer, the buttons are Back, Forward, Stop, Refresh, Home, Search, Favorites, History, Size, and Print.
Chapter 1: Getting Started
Overview of the SQL Assistant Interface

Browser Address Bar

You use the browser’s address bar to enter a URL to choose a data source.

For more information, see “Starting SQL Assistant” on page 19.

Description of Toolbar Icons

The Toolbar has a set of icons that allow you to control various functions of Teradata SQL Assistant.

Table 1 explains the function of each icon.

Table 1: Toolbar Icon Description

<table>
<thead>
<tr>
<th>Icon Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="icon" /></td>
<td>This icon disconnects SQL Assistant from the database and returns you to the logon screen. See “Disconnecting and Closing SQL Assistant” on page 22 for more information.</td>
</tr>
<tr>
<td><img src="image2" alt="icon" /></td>
<td>This icon opens a browse dialog box that allows you to browse for saved queries.</td>
</tr>
<tr>
<td><img src="image3" alt="icon" /></td>
<td>This icon submits the query in the Query pane to the database.</td>
</tr>
<tr>
<td><img src="image4" alt="icon" /></td>
<td>Click this icon to get an explanation of the query entered in the Query pane. The explanations shows the steps a query goes through. For more information, see “Using the Explain Query Feature” on page 30.</td>
</tr>
<tr>
<td><img src="image5" alt="icon" /></td>
<td>This icon stops the currently running query.</td>
</tr>
<tr>
<td><img src="image6" alt="icon" /></td>
<td>Enter the maximum number of rows you want the query to return. If the query returns more rows than the maximum limit, a message appears showing the number of rows that do not appear.</td>
</tr>
<tr>
<td><img src="image7" alt="icon" /></td>
<td>This icon displays and hides the Database Explorer Tree. For more information, see “Showing or Hiding the Database Explorer Tree” on page 54.</td>
</tr>
<tr>
<td><img src="image8" alt="icon" /></td>
<td>This icon opens the Query Builder dialog to help you build queries. For more information, see “Using Query Builder” on page 38.</td>
</tr>
<tr>
<td><img src="image9" alt="icon" /></td>
<td>This icon allows you to change the database password. See “Changing the Database Password” on page 29 for more information.</td>
</tr>
<tr>
<td><img src="image10" alt="icon" /></td>
<td>This icon opens the Options dialog. For more information on the Option dialog, see “Using the Options Dialog Box” on page 25.</td>
</tr>
<tr>
<td><img src="image11" alt="icon" /></td>
<td>This field shows the data source and user name SQL Assistant is logged currently logged on to.</td>
</tr>
</tbody>
</table>
Using the Options Dialog Box

The Options dialog box allows you to set various features for Teradata SQL Assistant for the Web.

To open the options dialog

1. Click the **Options** Dialog box icon. The options dialog box opens.
2. Use the tabs to navigate. Enter changes for each area. Table 2 explains the options available on each tab.
3. After setting your options, click **OK** to save the changes.

Table 2 shows the options that can be changed. Figure 2 shows an example of the Options dialog box.

Table 2: Description of the Option Dialog

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Query Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Prompt for a note before running any query options</td>
<td>Select this option if you want to add a note before running a query. When you run a query, you will be prompted with a Query Note dialog. Fill in the note as desired, then click OK. The query continues. The default for this setting is unchecked.</td>
</tr>
<tr>
<td>Stop query execution if an SQL error occurs</td>
<td>Stops a query execution if an error occurs. Applies to queries containing multiple statements. If unchecked, Teradata SQL Assistant continues to process statements that follow the statement that generated the error. The default for this setting is checked.</td>
</tr>
<tr>
<td><strong>Answer Set Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Close Answer Set tabs before submitting a new query</td>
<td>This option closes the Answer Set tabs before running a new query. The default for this setting is checked.</td>
</tr>
</tbody>
</table>
### Table 2: Description of the Option Dialog  (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display grid lines in answer sets</td>
<td>This option displays grid lines between the answer set cells. The default for this setting is checked.</td>
</tr>
<tr>
<td>Shade alternate rows in answer sets</td>
<td>This option applies shading to alternate rows in the answer set for easier reading. The default for this setting is checked.</td>
</tr>
<tr>
<td>Display 1000 separators in numeric columns</td>
<td>This option displays the comma in numbers greater than 1000. For example, 1,000. The default for this setting is unchecked.</td>
</tr>
<tr>
<td>Show alert when answer set exceeds maximum rows</td>
<td>This option shows a alert message if the number of rows returned from a query exceeds the maximum row amount set. The default for this setting is checked.</td>
</tr>
<tr>
<td>Max Rows</td>
<td>Enter the maximum number of rows you want SQL Assistant to show per query. If the number of rows returned exceeds this amount, you will be prompted. The default for this setting is ”2000”.</td>
</tr>
</tbody>
</table>
| Display this string for Null data fields         | Use this string to represent a null value resulting from a SELECT statement. The default setting for this option is “?”.
| Number of decimal places to display for Float columns | Enter a number between 0 and 9 to define the number of decimal places initially displayed in the answer set grid when the data originated from a column defined as float data type. The default setting is “2”.
| Handle Binary/Byte columns as BLOBs if size >    | Enter a number between 0 and 64000. 0 - All Binary/Byte columns will be treated as BLOBs. 64000 - Binary/Byte columns will never be treated as BLOBs. Binary/Byte columns larger than this value will be treated as BLOBs. The default setting for this option is “30”.

### History Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continually update the history table</td>
<td>This option sets the History pane to be continually updated. The default for this setting is checked.</td>
</tr>
<tr>
<td>Record only queries that run successfully</td>
<td>This option tells Teradata SQL Assistant to record only successful queries into the History pane. The default for this setting is unchecked.</td>
</tr>
<tr>
<td>Do not save duplicate queries in history</td>
<td>This option tells Teradata SQL Assistant not to save duplicate queries in the History pane. The default for this setting is unchecked.</td>
</tr>
</tbody>
</table>
Table 2: Description of the Option Dialog (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shade alternate rows in the history table</td>
<td>This option shades alternate rows in the History pane for easier reading.</td>
</tr>
<tr>
<td></td>
<td>The default for this setting is checked.</td>
</tr>
<tr>
<td>Show delete confirmation dialog</td>
<td>This option displays a confirmation dialog when information is deleted.</td>
</tr>
<tr>
<td></td>
<td>The default for this setting is checked.</td>
</tr>
<tr>
<td>Maximum number of history rows to display</td>
<td>Use this option to indicate the maximum number of row displayed in the History pane.</td>
</tr>
<tr>
<td></td>
<td>The default for this setting is 200.</td>
</tr>
</tbody>
</table>

Figure 2: The Options Dialog Box

Query Pane

Use the Query pane to enter and execute a query, automatically run or load a query from a file, or save a query to a file.

```
EXPLAIN set employee 
SHOW SELECT FROM MyJoinView; 
SELECT Name, Loc 
FROM employee, Department 
WHERE employee.DeptNo = Department.DeptNo 
AND employee.DeptNo IN 
  ( SELECT DeptNo FROM Department 
    WHERE MgrNo = 10007 ) ;
```
For more information about the Query pane, see “About the Query Pane” on page 33 and “How to Use the Query Pane” on page 34.

### History Pane

Use the History pane to view a table of your past queries and their related processing attributes. You can clear (delete) the information in this pane or save the information to a file.

<table>
<thead>
<tr>
<th>Run Date and Time</th>
<th>Source</th>
<th>Elapsed</th>
<th>Rows</th>
<th>Error Notes</th>
<th>SQL Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>3/14/2006 2:07 PM</td>
<td>apple</td>
<td>00:00:04</td>
<td>0</td>
<td>3807</td>
<td>sel * from AccessRights</td>
</tr>
<tr>
<td>3/13/2006 4:05 PM</td>
<td>graham</td>
<td>00:00:02</td>
<td>35</td>
<td></td>
<td>sel * from employee;</td>
</tr>
<tr>
<td>3/13/2006 3:46 PM</td>
<td>savak</td>
<td>00:00:02</td>
<td>248</td>
<td></td>
<td>sel * from town configurations;</td>
</tr>
</tbody>
</table>

For more information about the History pane, see “About the History Pane” on page 45 and “How to Use the History Pane” on page 47.

### Answer Set Pane

You use the Answer Set pane to view a table with the results from your query. You can save the information to a file.

<table>
<thead>
<tr>
<th>DatabaseName</th>
<th>DatabaseId</th>
<th>OwnerId</th>
<th>PasswordString</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYSTEMFE</td>
<td>0000EB03</td>
<td>00000100</td>
<td>y65'-'eE'p6/02/02 20:10:56</td>
</tr>
<tr>
<td>EXUSER</td>
<td>00000500</td>
<td>00000500</td>
<td>y6E'0C2p0C6/02/02 19:58:26</td>
</tr>
<tr>
<td>CRASHDUMPS</td>
<td>0000ED03</td>
<td>00000100</td>
<td>yA'Gr06/02/02 20:21:16</td>
</tr>
<tr>
<td>CONSOLE</td>
<td>0000F003</td>
<td>00000100</td>
<td>?</td>
</tr>
<tr>
<td>TDPUSER</td>
<td>0000E903</td>
<td>00000100</td>
<td>yE'Gr06/02/02 20:10:41</td>
</tr>
<tr>
<td>SYSUXTLIB</td>
<td>0000EF03</td>
<td>00000100</td>
<td>?</td>
</tr>
<tr>
<td>SYS_CALENDAR</td>
<td>0000EE03</td>
<td>00000100</td>
<td>yOC6'UK6/06/02/02 20:21:35</td>
</tr>
</tbody>
</table>

For more information about the Answer Set pane, see “About the Answer Set Pane” on page 41 and “How to Use the Answer Set Pane” on page 42.

### Database Explorer Tree

Use the Database Explorer Tree to view databases and objects.

Click the plus sign next to a database name or folder to expand the tree and view the objects. The Database Explorer Tree is an optional feature that you can show or hide.
Chapter 1: Getting Started
Overview of the SQL Assistant Interface

For more information about using the Database Explorer Tree, see “About the Database Explorer Tree” on page 53 and “How to Use Database Explorer Tree” on page 54.

**Status Bar**

The status bar appears across the bottom of the browser and displays status information on your query. In the example below, the status bar shows an error message because the information requested in the query does not exist in the database.

In Microsoft Internet Explorer, after a query has executed successfully, the status bar shows, “Complete, x Rows Processed,” when the query is complete. Also, the status bar gives you database messages such as error code numbers and brief information to assist you in diagnosing an error. For more information on error codes, see Appendix A: “Troubleshooting.”

If you want to hide the status bar, from the View menu, uncheck Status Bar.

```
3007: Table/view/trigger/procedure 'dbsmgr_errortest' does not exist.
```

**Changing the Database Password**

You can change the password for the database by clicking the password icon on the tool bar. Clicking the icon opens a dialog. You must enter the old password, then the new password, then confirm the new password.

**Note:** If your original password was entered automatically, you can not change the password and the password change icon will be inactive.
Using the Explain Query Feature

The Query Explain icon ![icon] shows the steps a query takes to complete. The steps appear in the Answer Set pane. The explanation includes estimated times, number of rows (if applicable) and the various resources in the database affected by the query.

Figure 3 shows an example of an explanation of the following query:

```sql
select * from dbc.accounts
```

Figure 3: Example of a Query Explanation

Use the Query Explain feature to view the impact a query may have on database resources. The example above is an explanation of a simple query. Longer, more complex queries will require more database resources. The Query Explain dialog shows what the resource impact may be.

Shortcut Menus

You can use a shortcut menu to access routine functions. Right-click any area in the browser or press Shift-F10 to open a shortcut menu containing commands appropriate for that area.

Query Text Box Shortcut Menu

You can use a shortcut menu to access routine functions in the Query text box. Right-click any area within the Query text box or press Shift-F10 to display a shortcut menu containing commands.

Figure 4: Query Text Box Shortcut Menu
Clipboard Support for the Query Text Box

The purpose of clipboard support is to quickly access routine functions when you are using the Query text box.

In the Query text box, you can highlight with the mouse, double-click a word, repositioning the cursor, cut, copy, and paste.

The following commands are available using shortcut keys:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Undoes or reverses the last action you took.</td>
</tr>
<tr>
<td>Cut</td>
<td>Cuts the selected text from the Query text box and saves it to the Clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the selected text from the currently active window to the Clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes the contents of the Clipboard in your query at the current insertion point. If you have text selected in the Query text box, that text is replaced by the text from the Clipboard.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes any portion of the query that is highlighted.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all the text in the Query text box. The text is highlighted and future actions apply to the entire query as a whole. The primary use of this function allows you to copy the query to the Clipboard. Warning: Anything you type at this point replaces your entire query.</td>
</tr>
</tbody>
</table>

Setting Browser Window Font Size

You can maximize the information you see on your screen by adjusting the font size in the browser window. This may be particularly useful when you are viewing information in the History and Answer Set panes.

For Microsoft Internet Explorer, from the View menu, choose Text Size. Choose a smaller font size so you can see more information. In Netscape 7 or later, click the View menu and select Text Zoom, to change the font size.
The font size change applies to the current browser window and all browser windows you open in the future.

**Printing**

You can print the contents of the individual Query, History, and Answer Set panes by clicking the print icon on each pane. For more information, see the following sections:

- Printing a Query
- Printing the Answer Set Table
- Printing the History Table
- Printing a Query
- Printing the Answer Set Table
- Printing the History Table
CHAPTER 2

Using the Query Pane

In this chapter, you will become familiar with the features and functions of the Query pane. This chapter contains the following information:

- About the Query Pane
- How to Use the Query Pane
- Using Query Builder
- Printing a Query

About the Query Pane

In the Query pane, use the Query text box to enter and execute a query, automatically run or load a query from a file, or save a query.

Queries can have one or more statements, and can return zero or more answer sets. You can enter SQL, Data Definition Language (DDL), or Data Manipulation Language (DML) statements in the Query text box.

The following is an example of what the Query pane looks like, including an example query within the Query text box:

```
EXPLAIN sel * employee
SHOW SELECT * FROM MyJoinView;
SELECT Name, Loc
FROM employee, Department
WHERE employee.DeptNo = Department.DeptNo
AND employee.DeptNo IN
    ( SELECT DeptNo FROM Department
      WHERE MgrNo = 10007 ) ;
```

Before You Begin

The SQL, DDL, DML, and statements you create must conform to the syntax defined by the ODBC data source you are connected to.
You can create queries consisting of one or more statements. Each statement in the query is submitted separately to the Teradata Database, therefore, your query can return more than one answer set.

You cannot send the same query to multiple databases. A query can be sent to only one database at a time.

**Important:** To maintain security and to help maximize your server’s resources, your browser’s connection expires after 30 minutes of inactivity. If this occurs, you need to connect to the data source again. See “To connect to a Teradata Database” on page 20.

### Aborting Queries

You can abort or cancel a query using SQL Assistant or Teradata Manager.

**Aborting Queries Using SQL Assistant**

For more information, see “Aborting a Query in Progress” on page 36.

**Aborting Queries Using Teradata Manager**

A query running on the Teradata Database is the same, jobwise, no matter where it originates. As long as it is running on the database, it can be viewed and aborted by Teradata Manager.

Use the Session Information or the Teradata Performance Monitor applications. With the Idle Report in Session Information, you can even set thresholds so that queries are automatically aborted after they have been idle for more than the specified limit. For information, see the *Teradata Manager User Guide*.

### How to Use the Query Pane

#### Entering and Executing a Query

**To enter and execute a query**

After you establish a connection to a data source, you are ready to enter and execute a query.

**Important:** For your multi-statement queries to execute, insert a semicolon after each statement.

1. Click in the **Query** text box and type your statement, or see “Copying Queries from History Pane to the Query Pane” on page 47.

2. Click the execute icon \(\text{execute icon} \) to execute a query.

   After you click the execute icon, SQL Assistant submits the query in the Query text box to the database. Each statement in the query is submitted separately to the database.

3. From the **Answer Set** pane, view the results from your query. The results appear in one or more answer sets.
Chapter 2: Using the Query Pane

How to Use the Query Pane

For more information about the Answer Set pane, see Chapter 3: “Using the Answer Set Pane.”

4 Glance at the History pane. Your executed statement appears as the first row in the History pane.

For more information about the History pane, see Chapter 4: “Using the History Pane.”

Saving a Query

You can save a query so you can refer to it again at a later time. The following steps explain how.

Note: The following steps may differ depending on the browser version you are using.

To save a query

1 Click the Save icon in the Query pane.
2 In the Save Format dialog box, select one of the following:
   • SQL File (*.sql, opens in the application associated with the .sql extension)
   • Definition (*.ddl, opens in the application associated with the .ddl extension)
   • Text File (*.txt, opens in Notepad)
   • Unicode Text (*.txt, opens in Notepad)
3 A File Download dialog opens. Select either Open or Save. If you select Open, the file opens in the application associated with the file extension.
4 If you click Save, enter a file name and location, then click Save.

Automatically Running a Query from a File

You can automatically run a query from a file. The following steps explain how.

To automatically run a query from a file

1 Click the Open Query icon on the toolbar.
2 In the text box located above the Run button, enter the fully qualified name of a text file containing the query you want to run. To locate an existing text file, click Browse located to the right of the text box. From the Choose file dialog box, locate the text file and click Open.
Click Run.

The query is processed and a copy of the query appears in the Query text box at the same time as your answer set appears in the answer set table. The SQL statement stored in the History table is the query that was executed.

**Loading a Query from a File Without Running It**

Sometimes you may need to modify a query you saved to a file before you run it.

---

**To load a query from a file**

1. Click the Open Query icon on the toolbar.
2. In the text box located above the Load button, enter a fully qualified name of a text file containing a query you wish to load, or click Browse located to the right of the text box to find the file. From the Choose file dialog box, locate the text file and click Open.
3. Click Load.
   
   The query loads into the Query text box so you can make changes.
4. Modify the query as desired.
5. Click Execute to execute the query.

---

**Aborting a Query in Progress**

When you submit a query, you have the option to abort it in progress. You may want to abort a query in progress if it is taking longer to process than you thought or if you change your mind.

---

**To abort a query in progress**

✔ To abort a query in progress, click Abort icon on the Toolbar.

---

**Executing a Query for Large Objects (LOBs)**

SQL Assistant supports LOB (large object) queries. Types of LOBs include CLOBs (character large object), which are character-based objects, and BLOBs (binary large object), which are binary objects like pictures or graphics.

When you execute a query for LOB data (either CLOB or BLOB), SQL Assistant prompts you with the LOB Dialog box, shown in Figure 5. Use this dialog to change the name of the object or the extension. There is also a check box if you want to display the object in the answer set (appears for BLOBs only).
The LOB Dialog box is described in the following table.

Table 5: LOB Dialog Box Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Name</td>
<td>Shows the name of the database column where the object is stored.</td>
</tr>
<tr>
<td>File Name</td>
<td>Indicates the file name. The default is the Column Name. You can change the file name if you want.</td>
</tr>
<tr>
<td>FileType</td>
<td>Shows the file type of the object. You can change the file extension if you want. For example, if your query finds a BLOB, its extension will be .dat. You can change the extension in the LOB Dialog box to .bmp or .jpeg so the application you are using knows how to display the BLOB.</td>
</tr>
<tr>
<td>Display as picture in answer set</td>
<td>To display the BLOB object (usually a picture or graphic) in the answer set, click Display as picture in Answer Set check box. This check box does not appear when CLOB objects are queried.</td>
</tr>
</tbody>
</table>

Select OK when finished with the dialog box. SQL Assistant opens a LOB Dialog for each LOB object in the query. Fill in each dialog as necessary.

When the query is complete, the answer set appears in the Answer Set pane. Figure 6 on page 38 shows the Answer Set pane with a BLOB answer.

If the Display as picture in Answer Set check box is marked the object appears in the answer set. If the check box was not marked, a button is displayed in the answer set with the BLOB file name. Click the button and a secondary window opens showing the object. The following figure shows an answer set with both the objects displayed and the object buttons.
Saving Large Objects

Large objects can be saved clicking the save icon \( \text{save} \) in the Answer Set pane. All LOBs are automatically saved as .zip files.

Printing a Query

You can print a query using the following procedure.

To print a query

✔ Click the printer icon \( \text{printer} \) on the Query tab to print the query. A print preview window opens. Select File and Print..

The following is an example of the Query print window.

Using Query Builder

Query Builder is an SQL library tool used to show and build query statements. Query Builder is displayed in a floating window that opens when you are working in the Query pane.
To open Query Builder, click the SQL icon, SQL on the toolbar.

The Query Builder window has two panes. The pane on the left side shows the possible SQL commands. The right side is where the sample query is displayed. Figure 8 shows the Query Builder window.

Figure 8: Query Builder Window

Building a Query

Use the Query Builder to construct simple or complex queries.

From the drop-down list in the upper left corner, choose either SQL Statement or Procedure Builder.

Click the command in the left pane to automatically copy the statement into the Query window.

The following table explains each option.

Table 6: Query Builder Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL Statements</td>
<td>When you choose the SQL Statements option, the statement list in the left pane shows each of the statement types available on the current data source. Note: The Teradata syntax file includes new syntax to support Teradata V2R6. Select a command from the statement list in the left pane to display an example of its syntax in the right pane.</td>
</tr>
<tr>
<td>Procedure Builder</td>
<td>When you choose the Procedure Builder option, the left pane shows a list of statements that are valid only when used in a Teradata CREATE or REPLACE procedure statement. Select a stored procedure statement from the list in the left pane to display an example of its syntax in the right pane.</td>
</tr>
</tbody>
</table>
Inserting a Statement or Procedure into the Query Window

To Insert a Statement or Procedure into the Teradata SQL Query pane, click either the Insert link or the Replace link in the Query Builder window. Insert link places the statement after any existing statement in the Query pane. Replace deletes any statements in the Query pane and adds the statement from Query Builder.
CHAPTER 3

Using the Answer Set Pane

In this chapter, you will become familiar with the features and functions of the Answer Set pane. This chapter contains the following information:

- About the Answer Set Pane
- How to Use the Answer Set Pane

About the Answer Set Pane

In the Answer Set pane, you can see the answer set table that shows the results from your query. If a query returns multiple answer sets, each appears in its own answer set table.

In addition, you can save an answer set to a file. This enables you to analyze the data in Microsoft Excel. To learn how to save an answer set to a file, see “Saving an Answer Set to a File” on page 42.

The Answer Set pane is easy to navigate, and you can sort and print the answer set. For more information, see “Printing” on page 32.

The following is an example of the Answer Set pane. This is displaying one of three answer set tables:

<table>
<thead>
<tr>
<th>DatabaseName</th>
<th>DatabaseId</th>
<th>OwnerId</th>
<th>PasswordString</th>
<th>ProtectionType</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYSTEMFE</td>
<td>0000EB03</td>
<td>000000100</td>
<td>9687-853d6p05/02/02 20:10:56</td>
<td>F</td>
</tr>
<tr>
<td>EXTUSER</td>
<td>00000500</td>
<td>000000500</td>
<td>9cE1O2pQ6/06/02/02 19:58:26</td>
<td>N</td>
</tr>
<tr>
<td>CRASHDUMPS</td>
<td>0000ED03</td>
<td>000001000</td>
<td>9A8Cr95f46/06/02/02 20:21:16</td>
<td>F</td>
</tr>
<tr>
<td>CONSOLE</td>
<td>0000F003</td>
<td>00001000</td>
<td>?</td>
<td></td>
</tr>
<tr>
<td>TDFUSER</td>
<td>0000E903</td>
<td>000001000</td>
<td>9x93g9A66N06/02/02 20:10:41</td>
<td>N</td>
</tr>
<tr>
<td>SYSUDTLIB</td>
<td>0000EF03</td>
<td>000001000</td>
<td>?</td>
<td></td>
</tr>
<tr>
<td>SYS_CALENDAR</td>
<td>0000EB03</td>
<td>000001000</td>
<td>9sRO80UKF206/02/02 20:21:35</td>
<td>F</td>
</tr>
</tbody>
</table>
How to Use the Answer Set Pane

Viewing Your Results

When you run a query the results appear in the Answer Set pane.

Queries that return larger results may return more than one page of results. To view additional pages, click the number 2 in the lower left hand corner of the Answer Set pane. Click higher numbers to view additional results.

When you submit multiple statements from the Query pane to the Teradata Database, you can view the results of each statement by clicking the tabs: answer set 2, answer set 3, etc. The results returned are in the order they were submitted. For example, answer set 2 is the second statement you submitted.

The Answer Set tab is black for the answer set you are currently viewing. The remaining answer sets that are grayed out can be viewed by clicking the corresponding Answer Set tab.

Sorting an Answer Set

To sort an answer set

✔ Click any column heading to sort by the data in that column.

The data is initially sorted in ascending order. Clicking the same column heading again sorts the data in descending order.

Note: BLOBs and CLOBs can not be sorted.

Reordering Columns in an Answer Set

To reorder columns in an answer set

✔ Click on any column heading, then drag and drop it to the desired location in the answer set.

Saving an Answer Set to a File

To save an answer set and the column headings to a file, use the following procedure.
To save an answer set to file

1. Click the **Save** icon on the Answer Set pane.
2. From the **Save Format** dialog box, select one of the following:
   - Tab delimited (*.txt, opens in Notepad)
   - Comma Separated Value (*.csv, opens in Microsoft Excel)
   - HTML Document (*.html, opens in a new browser window)
   - XML Document (*.xml, opens in the current browser window)
   - Unicode Tab delimited (*.txt, opens in Notepad)
3. The **File Download** opens. Select **Save** or **Open**. If you select **Open**, the extension determines which application the file saves as.
4. If you click **Save**, enter the file name and location, then click **Save**.

Opening a Saved Answer Set with Microsoft Excel

You may want to open a saved answer set in Excel. The following steps explain how.

To open a saved answer set with Microsoft Excel

1. Open Excel.
2. From the **File** menu, choose **Open**.
3. In the **Open** dialog box, from **Files of type** list, choose **All Files**.
4. Highlight the .txt file you saved when you completed the procedure listed above, and click **Open**.
5. In the **Text Import Wizard** dialog box, choose **Delimited**, and click **Next**.
6. Make sure the delimiters **Tab** checkbox is selected, and click **Next**.
7. Make sure the **Column data format** is General, and click **Finish**.

Copying an Answer Set to the Clipboard

To copy a partial or whole answer set to the clipboard

1. Highlight the columns or rows in the answer set you want to copy.
2. From the **Edit** menu, click **Copy**. The contents of the highlighted cells are copied to the Clipboard.

Printing the Answer Set Table

You can print an Answer set using the following procedure.
To print the answer set

✔ Print the answer set table by clicking the print icon on the Answer Set tab. The following window opens. Select File, then click Print.

The following is an example of the Answer set window ready to print.

Figure 9: Answer set print preview window
In this chapter, you will become familiar with the features and functions of the History pane. This chapter contains the following information:

- **About the History Pane**
- **History Pane Control Items**
- **How to Use the History Pane**
- **Using the Edit History Dialog**

## About the History Pane

In the History pane, you can see the History table that shows your past queries and their related processing attributes. The most recently executed statement appears as the first row in the History table.

If you log into Teradata with a different user name in the future, your History pane will not contain a table until you send queries to the database.

In addition, you can:

- Delete individual queries.
- Sort the information in the History table.
- Clear (delete) the information from this table.
- Save the information to a file.
- Add notes to any row in the History table.
- Replace the current contents in the Query text box with the query contained in the SQL Statement column in the History table.
- Edit Individual Queries.

The following is the History pane displaying a sample History table:
Chapter 4: Using the History Pane
History Pane Control Items

The function of History pane items are described in the following table.

Table 7: History Pane Column Descriptions

<table>
<thead>
<tr>
<th>Table Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select All</td>
<td>None link</td>
</tr>
<tr>
<td>Clear checkbox</td>
<td></td>
</tr>
<tr>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>RunDate/EndTime</td>
<td></td>
</tr>
<tr>
<td>Source</td>
<td></td>
</tr>
<tr>
<td>Elapsed</td>
<td></td>
</tr>
<tr>
<td>Rows</td>
<td></td>
</tr>
<tr>
<td>Error</td>
<td></td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>SQL Statement</td>
<td></td>
</tr>
<tr>
<td>User ID</td>
<td></td>
</tr>
<tr>
<td>Fetch Time</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Multi-statement queries show the total number of rows returned for all queries.

For information on error codes and resolution, see “Viewing Error Code Information” on page 49.
How to Use the History Pane

The following information will help you become familiar with using the History pane.

Viewing Additional History Tables

The History table can contain multiple tables. The numbered links at the bottom of the table allow you to view different tables.

To view additional History tables

✔ To view different history tables, click the numbers in the lower left corner of the History pane.

Click higher numbers to view older history tables.

Copying Queries from History Pane to the Query Pane

To save time retying the text of a query, you can copy previous queries from the History pane to the Query pane.

To copy queries from the History pane

✔ Click the SQL statement you want to copy under the SQL Statement column in the History pane. It appears as a link under the SQL Statement column.

The SQL statement from the History table displays in the Query text box.

Sorting History

To sort the History table

✔ Click any column header again to sort the data in descending column.

Adding Notes

To add notes in the History pane

1 In the History table, click Edit link for the corresponding row. The Edit History dialog box opens.

2 Enter the desired information in the Your Notes box.
3 Click **Update** to add your notes to the History table, or click **Cancel** to erase the information and return to the browser window.

The added note appears in the History pane under the Notes column. To learn more about the Edit history dialog, see “Using the Edit History Dialog Box” on page 50.

**Saving History Rows**

You may want to save the columns in the History pane for later reference. The following steps explain how.

**Note:** You cannot reload a saved history file into a new History pane.

---

**To save History to a file**

1. Click **Save** icon on the History pane.
2. In the **Save Format** dialog box, select one of the following:
   - SQL File (*.sql, opens in the application associated with the .sql extension)
   - Definition (*.ddl, opens in the application associated with the .ddl extension)
   - Text File (*.txt, opens in Notepad)
   - Unicode Text (*.txt, opens in Notepad)
3. A **File Download** dialog opens. Select either **Open** or **Save**. If you select **Open**, the file opens in the application associated with the file extension.
4. If you click **Save**, enter a file name and location, then click **Save**.

**Copying Rows to the Clipboard**

---

**To copy rows from the History pane to the clipboard**

1. Highlight the columns or rows in the answer set you wish to copy.
2. Right-click and select **Copy**. The contents of the highlighted cells are copied to the Clipboard.

**Clearing History Rows**

The following section explains the options for clearing history rows.

**Warning:** These actions cannot be undone.

---

**To clear History rows**

✔ To clear (delete) specific rows in the History table, select the checkbox in the first column, then click the clear history icon on the History Pane. The selected rows are cleared.
To delete all the rows in the History table, click the **All** link on the history tab, then click the clear history icon. This action deletes the entire history table. There is no undo.

Click the **None** link to uncheck rows in the History table.

### Printing the History Table

You can print the history table using the following procedure.

**To print the History table**

- Click the printer icon  on the History tab to print the query. A print preview window opens. Select **File** and **Print**.

The following is an example of the print window.

![Print History Window](image)

### Viewing Error Code Information

The History table displays an error code when an error occurs. To view the entire error message open the Edit History dialog by clicking **Edit** for the corresponding row in the History table.

For information on error codes and resolution, refer to Appendix A: “Troubleshooting” or refer to Messages. See “Additional Information” on page 4.

### Using the Edit History Dialog

The Edit History dialog box allows you to view information about a specific query in the History pane. You can use the Edit History dialog box to do the following:

- Edit the text of an error message and other messages
- Add to notes to the specific SQL statement
- Updates an SQL statement

To open the Edit History dialog, click the **Edit** link on the row in the History pane containing the query you want to view.

![Edit History Dialog](image)
Chapter 4: Using the History Pane
How to Use the History Pane

Figure 11: Edit History Dialog Box

The top pane shows the SQL statement. The left side shows a list of information about the query.

- Add notes in the **Your Notes** field.
- The Result Message field shows the message generated when the SQL statement was submitted. This field also shows the complete error message if an error occurs.
- Use the controls on the bottom of the dialog to delete and update the dialog information.

Table 8 explains the fields in the History dialog box. You can not edit these fields. They are informational only.

Table 8: Edit History Dialog Field Descriptions

<table>
<thead>
<tr>
<th>Edit History Dialog Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Date</td>
<td>Shows the date the query executed and the time the query ended.</td>
</tr>
<tr>
<td>Run Time</td>
<td>Shows the run time of a query.</td>
</tr>
<tr>
<td>Elapsed</td>
<td>Shows the total elapsed time to run a query.</td>
</tr>
<tr>
<td>Database Time</td>
<td>Shows the amount of time the query ran on the database.</td>
</tr>
<tr>
<td>Fetch Time</td>
<td>Shows the time taken to return the data.</td>
</tr>
<tr>
<td>Rows</td>
<td>Indicates the number of rows matching the query submitted.</td>
</tr>
<tr>
<td>Source</td>
<td>Indicates the name of the ODBC data source SQL Assistant is connected to when the query was executed.</td>
</tr>
<tr>
<td>Edit History Dialog Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>User ID</td>
<td>Shows the User ID who submitted the query.</td>
</tr>
</tbody>
</table>
CHAPTER 5

Using the Database Explorer Tree

In this chapter, you will become familiar with the features and functions of the Database Explorer Tree. This chapter contains the following information:

- About the Database Explorer Tree
- How to Use Database Explorer Tree

About the Database Explorer Tree

The Database Explorer Tree lists databases and objects in the Teradata Database server to which you are connected.

You can use the Database Explorer Tree to:

- View the hierarchy so you can see the objects when you create or delete them.
- Find table and column names, as well as object names.

When you start SQL Assistant, the following databases appear in the Database Explorer Tree: dbc, the database associated with the username used to connect to the Teradata Database server, and your default database (if it is different from username).

The databases do not have to be visible in the Database Explorer Tree in order for you to send queries. You can send queries to any database as long as your DBA has set access permissions.

The Database Explorer Tree appears on the left side of your browser.

You can click the plus sign next to a database name to see folders for tables, views, macros, functions, and procedures associated with that database.
How to Use Database Explorer Tree

The following information helps you become familiar with using the Database Explorer Tree.

Showing or Hiding the Database Explorer Tree

The Database Explorer Tree automatically appears when you start SQL Assistant.

To display or hide the Database Explorer Tree, click the **Database Tree** icon on the toolbar.

For more information, see “Resizing the Database Explorer Tree Area” on page 54.

Resizing the Database Explorer Tree Area

To resize the width of the Database Explorer Tree area, click the right edge of the Explorer Tree frame. The mouse pointer becomes a double arrow. Drag the arrow horizontally to change the size of the display.

Viewing Object Types

**Expanding the Branches**

To expand the tree to show all of the objects, click the plus sign (+) next to the database name or folder.

Expanding the folder loads only those object types. If no objects exist for a given object type, the folder remains but no objects appear below the folder and the plus sign disappears to give you a visual cue that no objects are in the folder.

**Collapsing the Branches**

To collapse the tree to hide all of the objects, click the minus (-) sign next to the database name or folder.

Object Types in the Database Explorer Tree

When you create a new object, it will not appear in the Database Explorer Tree until you open the parent folder. If the parent folder is already open or has been opened during your current session, the new object does not appear until after you disconnect and reconnect to the database. The same holds true when you remove an object.
Adding or Removing a Database

**Note:** The following procedure opens a secondary window. Please be sure to turn off any pop-up blockers.

### To add a database to the database explorer tree

1. From the Database Explorer Tree, click **Add**.
2. Enter the database name in **Database Name** text box.
3. Click **OK**.

The database you added is displayed in the Database Explorer Tree.

**Note:** If you try to add a database that does not exist in the Teradata Database, a message appears explaining the database or user does not exist. The database will not be added to the Database Explorer Tree.

### To remove a database from the database explorer tree

1. From the Database Explorer Tree, click **Remove**.
2. Enter the database name in **Database Name** text box.
3. Click **OK**.

The database you removed is no longer displayed in the Database Explorer Tree.

If you inadvertently remove a database, you can add it again.

**Note:** You cannot remove your default database from the Database Explorer Tree.
This appendix gives you recommended solutions to common errors or messages as well as helpful hints.

- Error Codes in the History Table
- Browser Messages and Errors
- Helpful Hints

### Error Codes in the History Table

If you submit a query and receive an error code in the Error column of the History table, review the following list of recommended solutions:

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Solution</th>
</tr>
</thead>
</table>
| 1811       | The server PC may no longer be connected to the data source. Do the following:  
1. Close your browser.  
2. Reopen your browser and log on.  
3. If you are submitting your request from a client PC, ensure the connection from the server PC to the database is still active.  
4. Resubmit your query. |
| 3707       | The SQL statement may contain incorrect syntax. Do the following:  
1. Recheck your SQL statement.  
2. Resubmit your query. |
| 3802       | The database name in the SQL statement does not exist. Do the following:  
1. Recheck your SQL statement.  
2. Resubmit your query. |
| 3807       | The SQL statement may contain a reference to a table or object that does not exist. Do the following:  
1. Recheck the name of the table or object, or, quantify the table name with a database name. For example <database.tablename>.  
2. Resubmit your query.  
**Note:** SQL Assistant does not support the SQL DATABASE command. If you want to change your default database to something other than your username, disconnect and log back in, then enter the desired default database in the Default Database text box. |
To avoid errors, check to ensure you have logged into a database that exists and the Teradata Database name is valid.

For additional information on error codes and how to resolve problems, refer to *Messages*, specifically Chapter 6: Messages and Chapter 15: Client UTY. See "Additional Information" on page 4.

**Browser Messages and Errors**

If you submit a query and receive a browser message or error, review the list below of recommended solutions.

To avoid errors, check to ensure you have logged into a database that exists and the Teradata Database name is valid.

<table>
<thead>
<tr>
<th>Message or Error</th>
<th>Explanation and/or Solution</th>
</tr>
</thead>
</table>
| Server Application Unavailable                        | 1 Click the Refresh button in the browser toolbar.  
|                                                       | 2 Click Retry.              
|                                                       | 3 Resubmit your query.      |
| Server Error in Application: Object reference not set to an instance of an object. | 1 Close your browser.      
|                                                       | 2 Open your browser and connect to the database.  
|                                                       | 3 Resubmit your query.      |
| Your session has timed-out due to inactivity.         | Your session with the server PC expired due to inactivity from your client PC. This occurs for security reasons and to help maximize server resources.  
|                                                       | Click the "Click here to reconnect" link to reconnect to the server. You will be prompted to choose a server and enter a user name and password. |
| Data type mismatch in criteria expression.           | If you receive this message, the SQL request you submitted does not appear in the History table. Your current Regional Options setting is restricting your ability to maintain the history of submitted SQL requests.  
|                                                       | To correct this problem, do the following:  
|                                                       | 1 From your Microsoft Windows desktop, click Start.  
|                                                       | 2 Go to Settings, select Control Panel, and select Regional Options.  
|                                                       | The Regional Options dialog box opens.  
|                                                       | 3 From the Your locale (location) menu, choose English (United States).  
|                                                       | 4 Click OK to accept the change and close the Regional Options dialog box.  
|                                                       | 5 Resubmit your query.      |

**Helpful Hints**

The following section contains helpful hints.
INTERVAL Data Type

SQL Assistant does not support the INTERVAL data type.

When selecting columns of data type INTERVAL, the following message appears in the answer set instead of the correct data.

```
INTERVAL data types are not currently supported. Please resubmit your query without the INTERVAL column: myInterval
```

Helpful Hint: Resubmit your query without the INTERVAL column.

TITLE Keyword

SQL Assistant does not support the TITLE keyword.

Helpful Hint:

Instead of entering the following syntax:

```
sel lastname (TITLE 'myname') from employee;
```

Enter the following instead:

```
sel lastname AS myname from employee;
```

This query will generate the expected column headings in the Answer Set pane.

Restarting the ASPNet_wp.exe Process

If you are having trouble loading SQL Assistant, it might be a problem with the aspnet_wp.exe process, which is needed to run SQL Assistant properly.

Restarting this process may solve the problem.

This process only works from the Teradata SQL server, not on the client machine.

---

To reset the aspnet_wp.exe

1. Open the Task Manager (Ctrl+Alt+Del, select Task Manager), and select the Processes tab.
2. Highlight the aspnet_wp.exe process.
3. Click End Process. There will be a series of warnings. Click Ok.

Once the aspnet_wp.exe process is ended, Windows automatically restarts it. If this was the problem, you should be able to load SQL Assistant now.
BLOB  An acronym for binary large object. A BLOB is a large database object that can be anything that doesn’t require character set conversion. This includes MIDI, MP3, PDF, graphics and much more. BLOBS can be up to 2 GB in size.

CLOB  An acronym for character large object. A CLOB is a pure character-based large object in a database. It can be a large text file. HTML, RTF or other character-based file. CLOBs can be up 2 GB in size. Also see BLOB and LOB.

column  In the relational model of Teradata SQL, databases consist of one or more tables. In turn, each table consists of fields, organized into one or more columns by zero or more rows. All of the fields of a given column share the same attributes.

data definition language (DDL) statements  In Teradata SQL, the statements and facilities that manipulate database structures and the Data Dictionary information kept about these structures. These statements include CREATE, DROP, ALTER, and MODIFY.

data manipulation language (DML) statements  In Teradata SQL, the statements and facilities that change the information content of the database. These statements include INSERT, UPDATE, and DELETE.

DBA  Database Administrator

DBC  Database Computer

DDL  Data Definition Language

delimiter  In Teradata SQL, a punctuation mark or other special symbol that separates one clause in a Teradata SQL statement from another or that separates one Teradata SQL statement from another.

DML  Data Manipulation Language

DNS  Data Source Name

Function  User Defined Functions (UDF) are extensions to Teradata SQL. Users can write UDFs to analyze and transform data already stored in their data warehouse in ways that are beyond the functionality of Teradata’s native functions.
**H**

**HTML**  Hypertext Markup Language

**I**

**IIS**  Internet Information Services

**IP**  Internet Protocol

**L**

**LOB**  An acronym for large object. A large object is a database object that is large in size. LOBs can be up to 2 gigabytes. There are two types of LOBs, CLOBs and BLOBs. CLOBs are character-based objects, BLOBs are binary-based objects.

**M**

**macro**  A set of Teradata SQL statements stored in the Teradata Database and executed by a single `EXECUTE` statement. Each macro execution is implicitly treated as a transaction.

**MDAC**  Microsoft Data Access Component

**O**

**Open Database Connectivity (ODBC)**  Under ODBC, drivers are used to connect applications with databases. The Teradata ODBC driver processes ODBC calls from an application, but passes SQL requests to the Teradata Database for processing.

**P**

**parameter**  In Teradata SQL, a variable name in a macro for which an argument value is substituted when the macro is executed.

**procedure**  Short name for Teradata stored procedure. Teradata provides Stored Procedural Language (SPL) to create stored procedures. A stored procedure contains SQL to access data from within Teradata and SPL to control the execution of the SQL.

**R**

**RDBMS**  Relational Database Management Systems

**request**  In host software, a message sent from an application program to the Teradata Database.

**S**

**SDK**  Software Development Kit
session  In client software, a logical connection between an application program on a host and the Teradata Database that permits the application program to send one request to and receive one response from the Teradata Database at a time.

SQL  Sequential Query Language

statement  A request for processing by the Teradata Database that is processed as a single entity and consists of a keyword verb, optional phrases, and operands.

T

table  In Teradata SQL, a set of one or more columns with zero or more rows with fields of related information. See also database.

V

view  In Teradata SQL, an alternate way of organizing and presenting information in the Teradata Database. A view, like a table, has rows and columns. However, the rows and columns of a view are not directly stored by the Teradata Database, but are derived from the rows and columns of tables (or other views) whenever the view is referenced.
Index

A
aborting queries 34
Account String field 21
Add button See Database Explorer Tree
adding
databases 55
notes 47
object types 54
answer set pane
overview 41
answer set table
clipboard, copying to 43
column headers 42
finding 23
font, changing 31
saving an answer set 42
sorting 42
viewing results 42

B
BLOB
defined 61
BLOBs See large objects
Browse button See Query pane
browser
address bar 24
browser window
closing 22
font size, changing 31
menu bar 23
shortcut menus 30
status bar 29
toolbar 23

C
cancelling
queries 34
Clear History button See History pane
client PCs
database, connecting to 20
SQL Assistant, how they work with 17
troubleshooting 57
clipboard
answer set, copying 43
history rows, copying 48

D
data definition language
defined 61
statements 33
data manipulation language
defined 61
statements 33
data source
defining 17
database
connecting 19
disconnecting 22
Database Explorer Tree
Add button 55
branches
collapsing 54
expanding 54
closing 54
databases
adding 55
dbc 53
default 53
removing 55
object types
adding 54
removing 54
viewing 54
opening 54
overview 53
Remove button 55
resizing 54
dbc database 53
dbc name or address 21
DDL See data definition language
default database 53
Default Database field 21
Delete command, Query text box 30, 31
delimiter, defined 61
DML See data manipulation language
documentation
installation 17
DSN
system 18
user 18

E
Edit menu
  Copy command 31, 43, 48
  Cut command 31
  Find command 23, 31
  Paste command 31
  Select All command 31
Elapsed column, History table 46, 50
Endtime column, History table 46
entering a query 34
error codes
  column in History table 46
troubleshooting 57
  viewing 49
errors See troubleshooting
Execute button See Query pane
executing a query 34

F
Favorites menu 20
features, SQL Assistant 15
Fetch Time column, History table 46, 50
File menu 22
files, running a query from 35
Find command, Query text box 31
find feature 23
font size, changing 31
Function
  defined 61

H
History pane
  Clear History button 48
overview 45
Save History button 48
History table
  clearing history 48
  clipboard, copying to 48
column
  headers, sorting 47
  names and descriptions 46, 50
error codes 46, 49, 57
  finding 23
  history rows
    saving 48
  viewing 47
  navigating 47
  notes, adding 47
  viewing 47

I
installing
  information 17
Internet Explorer, using
  answer set, saving 42
  browse window, closing 22
  clipboard support 31
  Database Explorer Tree, showing or hiding 54
  finding 23
  font size, setting 31
  history rows, saving 48
  query, saving 35
  Teradata database, connecting to 20
  URL, saving 20
INTERVAL data type 59
IP address, finding 19

L
large objects
  query for large objects 36
Load button See Query pane
LOBs See large objects

M
macros
  Database Explorer Tree, adding macros 55
defined 62
main window, SQL Assistant 22
menus
  Edit menu 23, 43, 48
  Favorites menu 20
  File menu 22
  Search menu 23
  shortcut menu, Query text box 30
  View menu 29
Index

N
notes
adding 47
notes column, History table 46

O
object reference not set to an instance of an object 58
object types, viewing 54
ODBC
  connection, setting up a 17
  data source administrator 18
  data source, defining 18
defined 62
overview
  SQL Assistant 15
overviews
  Answer Set pane 41
  Database Explorer Tree 53
  History pane 45
  Query pane 33

P
parameters
  Database Explorer Tree, adding parameters 55
defined 62
Password field 21
Paste command, Query text box 30, 31
Printing
  answer set table 43
  history table 49
  query window 38
procedures
  Database Explorer Tree, adding a procedure 55
defined 62
product version numbers 3

Q
queries
  aborting 34
cancelling 34
Copy command 31
copying 31
entering 34
executing 34
finding 23
loading 36
notes, adding 46
printing 32
running from a file 35
saving 35
Query Builder
  inserting statement or procedure 40
Query pane
  Browse button 35
  Execute button 34
  Load button 36
  overview 33
  Run button 35
  Save Query button 35
Query text box
  clipboard support 31
  commands
    Copy 31
    Cut 31
    Delete 31
    Find 23, 31
    Paste 31
    Select All 31
    Undo 31
  commands and descriptions 31
  shortcut menu 30

R
Refresh button 58
Remove button See Database Explorer Tree
requests, defined 62
rows column, History table 46, 50
Run button See Query pane
Run Date and Time column, History table 46, 50

S
Save History button See History pane
Save Query As command 35
Save Query button See Query pane
saving
  a query 35
  an answer set 42
  history rows 48
Search menu, Find command 23
Select All command 30, 31
server PC
  application unavailable error 58
  computer name, finding 19
error in application 58
  how it works 17
  IP address, finding 19
troubleshooting 57
sessions
  Database Explorer Tree 54
defined 63
setting up an ODBC connection 17
shortcut menus
  browser window 30
  Query text box 30
  Show Tree check box 54
Index

software releases supported 3
sorting answer set 42
Source column, History table 46, 50
SQL Statement column, History table 46
SQL Assistant how it works 16
  key features 15
  main window 22
  overview 15
  starting 19
statements DDL 33
  defined 63
  DML 33
  multi-statement queries, creating 34
  SQL 33
  statements, creating 34
status bar, browser window 29
stored procedures creating 39
  inserting into Query window 40
syntax using Query Builder 38
system DSN 18

T
tables Database Explorer Tree, adding tables 55
  defined 63
Teradata Database ODBC
  data source, defining 17
  driver, installing a 17
  submitting queries 34
text size, changing 31
TITLE keyword 59
troubleshooting 57

U
Undo command, Query text box 30, 31
user DSN 18
  ID column, History table 46, 51
Username field 21

V
version numbers 3
View menu
  status bar, displaying 29